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1 Overview to Patron Self Loan 
 
CyberTools Patron Self Loan allows a patron to sign in and borrow items. Although the function can run 
via a browser, it runs better when used with the CyberJ Desktop Client. This guide discusses how to 
setup and run Patron Self Loan. The steps are:  
 

  1. Document your best Staff Function option from your Catalog Functions  

     and Knowledge Center homepage at CyberTools;  

  

  2. Run Staff Functions (3-8)-> Properties->My URLs, CyberJ Setup, and HTML  

     Code for the CyberJ Desktop Client settings;  

  

  3. Install and Setup the CyberJ Desktop Client;  

  

  4. Run Patron Self Loan.  

  

This guide's next section, 2, "Install the CyberJ Desktop Client for Patron Self Loan", documents steps 1 
through 3. It is followed by section 3, "Run Patron Self Loan".  
 

Full instructions are at the CyberTools Knowledge Center  
 

   http://cybertoolsforlibraries.com/library/library.php#CIRC  

   - Patron Self Loan Guide  

  

This document is the Patron Self Loan Guide.  
 

If you are running Patron Self Loan, you probably want to install a single-app kiosk solution for your public 
workstation. Any search engine will help you find one. Please also look at the Microsoft Windows 10 
solution "Set up a single-app kiosk" found at  
 

    https://docs.microsoft.com/en-us/windows/configuration/kiosk-single-app 

 

 

  

https://docs.microsoft.com/en-us/windows/configuration/kiosk-single-app


Patron Self Loan   ©CyberTools Inc. 1998-2020 

3 

2 Install the CyberJ Desktop Client for Patron Self Loan 
 
2.1 Overview to My URLs, CyberJ Setup, and HTML Code 
 
Function [My URLs, CyberJ Setup, and HTML Code] displays a library's specific URLs for Staff Function, 
Circulation Only Function, and Patron Self-Loan. It also displays their setup values for the CyberJ 
Desktop Client. This function also displays URLs for the OPAC, A to Z Groups, and OpenURL. Lastly, this 
function generates HTML form code for Search Catalog and A to Z that can be inserted into any HTML 
web page.  
 

CyberTools Staff Functions and Circulation Only Functions are generally accessed from your library's 
Catalog Functions and Knowledge Center homepage at CyberTools. It looks like this:  
 

 ------------------------------------------------ 

 CyberTools for Libraries Catalog Functions  

  

 My Organization's Name Here  

 My Library's Name Here  

  

  1. Search the Catalog (a.k.a.HTML OPAC)  

  2. Search the Catalog for the Visually Impaired  

  3. Staff Functions (port 20,004)  

  4. Staff via best Firewall Backdoor (port 21)  

  5. Staff via new Firewall Backdoor (port 563)  

  6. Staff via alternate Firewall Backdoor (port 23)  

  7. Staff via Tunnel  

  8. Staff via FIPS mode Secure Tunnel  

  

 ------------------------------------------------ 

  

When function 3 through 8 are selected, the browser downloads a program named CyberJNLP.jlnp from 
the CyberTools server. When the program runs, it launches a small Java applet window named "CyberJ 
Java Web Start Applet". The applet then connects to the CyberTools server and runs your CyberTools 
application. Window "CyberJ Java Web Start Applet" has a push button [Run] that allows a new 
connection to the server without downloading the program again.  
 

Although the above process works well, its startup takes too long for Patron Self Loan. You need to install 
the CyberJ Desktop Client for function Patron Self Loan.  

 
2.2 My URLs, CyberJ Setup, and HTML Code 
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2.3 Fields:  My URLs, CyberJ Setup, and HTML Code 
 
2.3.1 Field 1 Organizational Library Name:  50 characters, display only 
Identifies the organization name of the library.  
 
2.3.2 Field 2 Catalog Name:  50 characters, display only 
Field Catalog Name displays the full name of the catalog. This is in contrast to the catalog's short name. 
Both are controlled by Main Menu Properties->Library Name, Address, Phone.  
 
2.3.3 Field 3 Function:  mandatory 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Staff Function URL & CyberJ Setup 
Circulation Only URL & CyberJ Setup 
Patron Self Loan URL & CyberJ Setup 
OPAC URL 
Search Catalog HTML Form 
A to Z URLs 
A to Z HTML Forms 
Old CyberTools OpenURL 
ANSI OpenURL 
 
Purpose: The Function menu selection determines the application for which the appropriate URL or 
HTML form code will be displayed. URLs and other information can be displayed for Staff Functions, 
Circulation Only, Patron Self Loan, OPAC, or A to Z. In addition, OpenURLs for specific resources can be 
displayed in either CyberTools proprietary mode or ANSI Z39.88.  
 

These options:  
 

 - Staff Functions URL & CyberJ Setup  

 - Circulation Only URL & CyberJ Setup  

 - Patron Self Loan URL & CyberJ Setup  

  

produce output as follows:  
 

  Application Setup for CyberJ Client and/or URLs  

  Setup values for the function Patron Self Loan via mode port 20004  

  

  CyberJ Desktop Client New/Edit Application field values  

  

  Application Name = Patron Self Loan  

  Remote IP or Node Name = 127.0.0.1  

  Remote Port# = 20001  

  Use Tunnelling Only?  NOT SELECTED  

  Make Default Application?  NOT SELECTED UNTIL IT WORKS  

  Tunnelling URL = LEAVE BLANK  

  Xecute string or Application Key = MyLibraryIdentifierPSL  

  Router IP or Node Name = MyServer.com  

  Router Port# = 20004  

  Use CyRouter? SELECTED  

  End of CyberJ Desktop Client setup.  

  Run the CyberJ Desktop Client, select Application then New or Edit,  

  and copy the above values into the CyberJ fields.  

  ===========================================================  

  URL for your browser:  

  http://MyServer.com/CyberJNLP.php?xec=C4LPSL  

  &UseRouter=1&mnode=127.0.0.1&mport=20001&portnum=20004  

  

If the library chooses to continue with the browser then the value from "URL for your browser" is used. If 
the library is running the CyberJ Desktop Client then the top part of the display is copied to the CyberJ 
Desktop Client.  
OPAC URL will display a format similar to this:  
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 http://MyServer/MyTomCatPath/CyberHTML?MyLibraryIdHO 

  

The Search Catalog HTML Form generates HTML form code that can be inserted into any HTML page. 
The form will be similar to this:  
 

 <HTML><HEAD><TITLE>Search Catalog</TITLE></HEAD><BODY>  

 <!-- Remove the first, second, and last lines when inserting  

  into an existing HTML page.-->  

 <form action="http://MyServer/MyTomCatPath/CyberHTML"  

 method="get">  

 <input name="MyLibraryIdLINK&url_ver" type="hidden"  

  value="Z39.88-2004">  

 <label for="KEYWORD">Keyword</label>  

 <input id="KEYWORD" name="KEYWORD" size="25" type="TEXT">  

 <input type="submit" value="Search">  

 </form>  

 </BODY></HTML>  

  

This form is using the CyberTools OpenURL. It can vary the query, e.g., instead of KEYWORD it can use 
TITLE, ISSN, ISBN, etc. Please see the CyberTools OpenURL documentation on the Knowledge Center 
web site.  
 

When A to Z URLs is selected, the URL for the primary/default A to Z list is displayed. That display is 
followed by the URL for each A to Z list. For example:  
 

 URL to primary/default A to Z List:  

 http://MyServer/MyTomCatPath/CyberHTML?MyLibraryIdA2Z  

  

 Biography:  

 http://MyServer/MyTomCatPath/CyberHTML?MyLibraryIdA2Z+BIO  

  

 Fiction:  

 http://MyServer/MyTomCatPath/CyberHTML?MyLibraryIdA2Z+FCTN  

  

 Journals:  

 http://MyServer/MyTomCatPath/CyberHTML?MyLibraryIdA2Z+JRNL  

  

If "A to Z HTML Forms" is selected, the program will show the HTML that can be added to your home 
page to display each individual group, and also the HTML that will display all the groups together. The 
form will be similar to this:  
 

 <HTML><HEAD><TITLE>Journals, Print by Title</TITLE></HEAD><BODY>  

 <!-- Remove the first, second, and last lines when inserting  

 into an existing HTML page.-->  

 <form action="http://MyServer/MyTomCatPath/CyberHTML"  

 method="post">  

 <input name="cyAppID" type="hidden" value="MyLibraryIdAZP">  

 <input name="GRPTS" type="hidden" value="jp~1">  

 <H3>Journals, Print by Title</H3>  

 <INPUT type="submit" class="pb" name="CHAR1_A" value="A">  

 <INPUT type="submit" class="pb" name="CHAR1_B" value="B">  

 * * * S N I P * * *  

 <INPUT type="submit" class="pb" name="CHAR1_Z" value="Z">  

 <INPUT type="submit" class="pb" name="CHAR1_~" value="?123">  

 </form>  

 </BODY></HTML>  

  

The "Old CyberTools OpenURL" is provided for legacy applications. The "ANSI OpenURL" is the 
preferred format. It is used by link resolvers and for persistent OPAC links. The format is:  
 

 http://MyServer/MyTomCatPath/CyberHTML?MyLibraryIdLINK&url_ver=Z39.88-2004 

http://myserver/MyTomCatPath/CyberHTML?MyLibraryIdHO
http://myserver/MyTomCatPath/CyberHTML?MyLibraryIdLINK&url_ver=Z39.88-2004
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2.3.4 Field 4 Staff, Circ Only, & Patron Self Loan CyberJ Port Number:  mandatory 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Default port 20,004 
Best Firewall Backdoor via port 21 
New Firewall Backdoor via port 563 
Tunnel via port 80 
FIPS mode Secure Tunnel via port 443 
 
Purpose: Field Port determines which TCP/IP port the workstation will access on the server. These 
options are paired with the Function options  
 

 - Staff Function URL & CyberJ Setup  

 - Circulation Only Functions URL & CyberJ Setup  

 - Patron Self Loan URL & CyberJ Setup  

  

The choice should be made based on the library's experience running Staff Functions from the library's 
homepage at CyberTools. The page that looks something like this in the browser:  
 

 CyberTools for Libraries Catalog Functions and Knowledge Center  

  

 My Organization's Name Here  

 My Library's Name Here Catalog Functions  

  

  3. Staff Functions (port 20,004)  

  4. Staff via best Firewall Backdoor (port 21)  

  5. Staff via new Firewall Backdoor (port 563)  

  6. Staff via alternate Firewall Backdoor (port 23)  

  7. Staff via Tunnel  

  8. Staff via FIPS Port Secure Tunnel  

  

Choose the Port based on the library's typical selection from the above menu for a Staff Function (number 
3 through 8).  
 

"Default port 20,004" will attempt to connect to the server via CyRouter on port 20004. It corresponds to 
Catalog Functions->"3. Staff Functions (port 20,004)".  
 

"Best Firewall Backdoor via port 21" will attempt to connect to the server via CyRouter on port 21. It 
corresponds to Catalog Functions->"4. Staff via best Firewall Backdoor (port 21)".  
 

"New Firewall Backdoor via port 563" will attempt to connect to the server via CyRouter on port 563. It 
corresponds to Catalog Functions->"5. Staff via new Firewall Backdoor (port 563)".  
 

Port 23 is not used here.  
 

"Tunnel via port 80" will attempt to connect to the server via tunnelling on port 80. It corresponds to 
Catalog Functions->"7. Staff via Tunnel".  
 

"FIPS mode Secure Tunnel via port 443" will attempt to connect to the server via tunnelling using secure 
HTTP (https) with FIPS encryption using port 443. It corresponds to Catalog Functions->"8. Staff via FIPS 
Port Secure Tunnel".  
 
2.3.5 Field 5 Choice of the Target Device:   
Specifies the target device for the output. Choices include Workstation, Printer, File, or send to an E-mail 
address.  
 
Menu Style:  Push Button 
Menu Values: Workstation, Printer, File, E-mail, Close, & Help 
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2.4 Overview to the CyberJ Desktop Client 
 
The CyberJ Desktop Client is the same Java program that runs from your browser.  
 
The advantages of running CyberJ from a browser are:  
 

  - you always have the most current version (although we rarely change  

    CyberJ);  

  - you do not have to install software on your workstation.  

  

The disadvantages of running CyberJ from a browser:  
 

  - if your Java becomes out of date, your browser makes it hard to use;  

  - you need to wait for CyberJ to download each time you use it;  

  - there can be an occasional cranky browser or Java pop-up warning.  

  

The advantages of running the CyberJ Desktop Client are:  
 

  - starts immediately because of no download time;  

  - it's easy to double click on a desktop icon to connect you to the  

    application;  

  - no cranky browser or Java messages;  

  - can be used by old versions of Java.  

  

The disadvantages of running the CyberJ Desktop Client are:  
 

  - you have to manually update it (although we rarely change  

    CyberJ);  

  - can be difficult to download initially because of firewalls.  

  

CyberTools staff rarely use a browser to access the Catalog Functions. We almost always use the CyberJ 
Desktop Client.  
 

Before you install the CyberJ Desktop Client, make sure that you have a working version of Java. Try 
looking at your Windows Start, go to your alphabetic list of apps, and look for Java. Contact your IT group 
for help.  
 

Important note: Java 8 is a.k.a. 1.8, Java 7 is a.k.a. 1.7, Java 6 is 1.6, and Java 5 is 1.5. CyberTools 
didn't create this numbering system. Smart people in Silicon Valley came up with this.  

 
2.5 Before you start get your CyberJ Desktop Client Settings 
 
Before you start, you need to know your preferred Staff Functions port number. Go to your library's 
Catalog Functions and Knowledge Center homepage at CyberTools. It looks like this:  
 

------------------------------------------------ 

 CyberTools for Libraries Catalog Functions and Knowledge Center  

  

 My Organization's Name Here  

 My Library's Name Here Catalog Functions  

  

  1. Search the Catalog (a.k.a.HTML OPAC)  

  2. Search the Catalog for the Visually Impaired  

  3. Staff Functions (port 20,004)  

  4. Staff via best Firewall Backdoor (port 21)  

  5. Staff via new Firewall Backdoor (port 563)  

  6. Staff via alternate Firewall Backdoor (port 23)  

  7. Staff via Tunnel  

  8. Staff via FIPS mode Secure Tunnel  

  

 ------------------------------------------------ 
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Note which "Staff" works well for you and its port number.  
 

2. Using the above, sign into Staff Functions. Go to Properties->My URLs, CyberJ Setup, and HTML 
Code. Select a Function:  
 

   Staff Function URL & CyberJ Setup  

   Circulation Only URL & CyberJ Setup  

   Patron Self Loan URL & CyberJ Setup  

  

Using your preferred "Staff" from step 1, select a Port:  
 

   Default port 20,004  

   Best Firewall Backdoor via port 21  

   New Firewall Backdoor via port 563  

   Tunnel via port 80  

   FIPS mode Secure Tunnel via port 443  

  

Select function [Workstation] so that you can copy and paste the resulting values into the CyberJ Desktop 
Client later as part of step "Setup the CyberJ Desktop Client". It will look something like this:  
 

  ===========================================================  

  Application Setup for CyberJ Client and/or URLs  

  Setup values for the function Patron Self Loan via mode port 20004  

  

  CyberJ Desktop Client New/Edit Application field values  

  

  Application Name = Patron Self Loan  

  Remote IP or Node Name = 127.0.0.1  

  Remote Port# = 20001  

  Use Tunnelling Only?  NOT SELECTED  

  Make Default Application?  NOT SELECTED UNTIL IT WORKS  

  Tunnelling URL = LEAVE BLANK  

  Xecute string or Application Key = MyIdHereMyCyberToolsFunctionHere  

  Router IP or Node Name = cybertoolsforlibraries.com  

  Router Port# = 20004  

  Use CyRouter? SELECTED  

  End of CyberJ Desktop Client setup.  

  Run the CyberJ Desktop Client, select Application then New or Edit,  

  and copy the above values into the CyberJ fields.  

  ===========================================================  

 
2.6 Download the CyberJ Desktop Client 
 
Go to CyberTools for Libraries Knowledge Center->Browser and Connectivity at  
 

   http://CyberToolsForLibraries.com/library/library.php#BCUI 

  

Find the target CyberJ installation for your version of Java.  
 

  - Install CyberJ Desktop Client for Java 7, 8, or 9 * instructions  

    * direct download * right-click then save as  

  

  - Install CyberJ Desktop Client for Java 6 * instructions * direct  

    download * right-click save then as  

  

Option "instructions" is this document.  
 

Option "direct download" pushes the CyberJ program to your workstation: you should next see your 
standard browser download dialogue.  
 

Option "right-click then save as" is another way of downloading, but just more steps for you (but possibly 

http://cybertoolsforlibraries.com/library/library.php#BCUI
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more firewall-friendly). After right-clicking on the link, choose "Save Link As".  
 

Both methods deliver the same file. The two methods are provided in order to appease firewalls. You 
might need to deactivate your workstation malware service: remember to restart it after the download.  

 
2.7 Install the CyberJ Desktop Client 
 
The downloaded file is named CyberWeb_plugin1#.jar, where the # is your Java version number (6 or 7 
as of 2020-10-20). Create folder CyberJ anywhere on your workstation that you can save a file. Drag your 
CyberWeb_ plugin1#.jar to that folder.  
 

Make a shortcut for CyberWeb_plugin1#.jar to your desktop, then right click on the shortcut's icon and 
select Properties. Select tab Shortcut. Change the Target field to:  
 

  Version of Java  Target field value  

  ===============  ===================  

  7, 8, or 9       javaw.exe -cp .\CyberWeb_plugin17.jar CyberJ  

  6                javaw.exe -cp .\CyberWeb_plugin16.jar CyberJ  

  

Field "Start In" is the folder that now contains your CyberWeb_plugin1#.jar. Select function [Apply] then 
[OK].  

 
2.8 Setup the CyberJ Desktop Client 
 
Double click on your new desktop icon for CyberJ. If nothing happens then go to section Debugging and 
an Alternate Installation found below. When CyberJ runs then select Applications->New. Cut and paste 
the values from your "My URLs, CyberJ Setup, and HTML Code" output (see the above section "Before 
you start get your CyberJ Desktop Client Settings") into the New display. Save. Now run Applications-
>Run->YOUR_FUNCTION. If it works, then go back to Applications->Edit->YOUR_FUNCTION->Make 
Default Application?-> SELECTED and [Save]. Close CyberJ. Double click on your desktop icon for 
CyberJ: your application should run.  

 
2.9 Debugging and an Alternate Installation 
 
If CyberJ does not run, then you might not have a path to Java. Go to your Windows (DOS) Command 
Prompt (Windows Start button then type COMMAND in the field "Search programs and files"). In the old-
fashion Command Prompt window, type PATH and press ENTER. You should see something like this:  
 

  C:\Users\MyName>PATH  

  PATH=C:\ProgramData\Oracle\Java\javapath;C:\Program Files(x86)\  

  Intel\iCLS Client\; C:\Program Files\Intel\iCLS Client\;  

  C:\Windows\system32;C:\Windows; <snip>  

  

Do you see Java there? Probably not. To add Java to your PATH please see  
 

   https://www.java.com/en/download/help/path.xml 

       

Go back to Setup.  
 

Alternatively, you can explicitly state the path to Java in the shortcut's Target field. Use your Windows 
Explorer to search for your javaw.exe program. Hint: In Windows Explorer, choose your boot drive 
(typically C:) and use the search box located in the toolbar (or found on File->Search) to search for 
"javaw.exe". The search may take a couple of minutes. You may see more than one result for your 
search. Look for the path that is closest to the following:  
 

C:\Program Files (x86)\Java\jre7\bin\javaw.exe  
 

but yours can be different. Right click on the search result and copy the path. Paste it into NotePad or MS 
Word. Surround with double quotes, e.g.:  
 

https://www.java.com/en/download/help/path.xml
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   "C:\Program Files (x86)\Java\jre7\bin\javaw.exe"  

  

Copy from quote to quote inclusively. The quotes are needed because of the space in "Program Files".  
 

Right click on the shortcut's icon and select Properties. Select tab Shortcut. Remove the leading 
"javaw.exe". Paste in your copied quoted path and javaw.exe from above. It should look something like 
this:  
 

"C:\Program Files (x86)\Java\jre7\bin\javaw.exe" -cp .\CyberWeb_plugin17. jar CyberJ  
 

but for your version of Java. Select [Apply] and [Ok]. Go back to Setup.  
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3 Run Patron Self Loan 
 
3.1 Overview to Patron Sign In with Identifier and Password 
 
This Patron Sign In window starts the Patron Self Loan process. The patron uses a pair of unique values 
as credentials:  
 

   - Last Name,First Name  

   - Bar Code  

   - Additional Identifier  

   - E-Mail  

   - Password  

  

This window is one of two authentication windows. The other window allows sign in by bar code only.  

 
3.2 Patron Sign In with Identifier and Password 
 

 
 
3.3 Fields:  Patron Sign In with Identifier and Password 
 
3.3.1 Field 1 System Message:  65 characters, display only 
Purpose: To identify the purpose of the patron sign in. This window is used by many modules of the 
library system. The message in this field should assist the user in understanding why this window is being 
presented.  
 
3.3.2 Field 2 Patron Identifier:  40 characters, mandatory 
Purpose: To identify the patron prior to the patron applying a password.  
 

Format:  
 

  - the patron's name as Last,First;  

  

  - if the patron has a library card, then the bar code itself  

    or the decoded bar code values (usually printed above or  

    below the bar code itself);  

  

  - patron's e-mail address, as long as it's unique (not shared  

    with other patrons);  

  

  - any additional identification number in the patron's record.  
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3.3.3 Field 3 Password:  40 characters, mandatory, silent 
Purpose: To specify the password for this patron.  
 

Format: The form should be any combination of letters and numbers without punctuation. It must be at 
least three characters long.  
 

If the patron does not have a distinct password for the library, then any of the following values will function 
as the patron's password:  
 

     - if the patron has a library card, then the bar code itself  

       or the decoded bar code values (usually printed above or  

       below the bar code itself);  

  

     - any additional identification number in the patron's record.  

  

If the patron used any of the above values in the Name field, then the value cannot be used as the 
password.  
 
3.3.4 Field 4 Ok, Cancel, or Help:   
Purpose: Ok will apply the values to the database and exit the window. Cancel will reject the changes and 
exit the window. Help will invoke the hypertext for this window.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
Change password... 
Send a password to the above e-mail address 
Contact Library... 
 
Function [Change password...] requires you to sign in successfully. Success results in a form with the 
fields New Password and Confirm New Password. The password is validated with the library's password 
rules.   
 

Function [Send a password to the above e-mail address] tests the value in field "Unique E-mail address, 
Bar Code, or ID". If it is an e-mail address, and the e-mail address is in the library's database and is 
unique, then a new password is sent to the e-mail address.   
 

Function [Contact Library...] opens the local e-mail client with all of the known information for the patron 
displayed. The addressee is the library. The patron should complete the e-mail with his/her message and 
complete contact information.  
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3.4 Overview to Patron Sign In by Bar Code 
 
The Patron Self Loan starts with one of two sign in windows.  
 

  - Patron Sign In by Identifier and Password (the default);  

  - Patron Sign In by Bar Code (optional).  

  

The Patron Sign In by Bar Code uses the patron's bar code as the sole credential: no other values are 
required. This optional sign in is activated via Staff Function (3-8)-> Properties->Circ: Blocks, Fees, Fines 
& Options->Patron Self Loan Bar Code Only= SELECTED.  

 
3.5 Patron Sign In by  Bar Code 
 

 
 
3.6 Fields:  Patron Sign In by  Bar Code 
 
3.6.1 Field 1 Patron bar code:  40 characters 
Please scan your patron bar code. It might be on your library card, your employee id, or your student id. 
You may also type it then press ENTER.  
 
3.6.2 Field 2 Ok, Cancel, or Help:   
Purpose: Ok will apply the values to the database and exit the window. Cancel will reject the changes and 
exit the window. Help will invoke the hypertext for this window.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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3.7 Overview to Loans 
 
Function [Loan] is used for lending materials to patrons and for collecting patron fines and fees. The 
process for both is the same. First, the user identifies a patron. If the patron is new, and if the library 
allows the dynamic adding of patrons via Loans, then the user can add the patron, otherwise the session 
is over. If the patron is in the patron database, then the software checks to see if the patron is eligible to 
borrow materials. Eligibility is based on outstanding loans, fines, fees, and if the patron's account has not 
expired. Ineligibility is called a Circulation Block.  
 

Once identified, the circulation user may examine the patron's current loans, collect fines and fees, edit 
the patron's demographic record (if allowed), and execute a loan.  
 

Function [Loan] and [Loan with Override] differ in that the latter can override a Circulation Block. Also, 
[Loan with Override] can change the date and time of the loan.  

 
3.8 Patron Self Loan 
 
When used with function [Patron Self Loan], the patron signs in with one of two credentialing windows:  
 

  - Patron Sign In with Identifier and Password;  

  - Patron Sign In by Bar Code.  

  

After authenticating the patron, the standard function [Loan Item] runs. Field Patron Lookup is 
deactivated. Functions [Patron Edit], [Pay Fees], and [Pay Fines] are prohibited.  
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3.9 Loans 
 

 
 
3.10 Fields:  Loans 
 
3.10.1 Field 1 Alert Message:  72 characters, display only 
Purpose: To display an alert message that relates to a specific patron. An audible alert may also be 
sounded as the message is displayed.  
 
3.10.2 Field 2 Title:  10 characters, display only 
Purpose: To specify the patron title information such as Dr., Ms., etc.  
 

Format: The individual's title may contain any combination of letters, numbers, and punctuation.  
 
Discussion: An individual's title may be used to capture titles such as Mr., Ms., Dr., etc.  
 

   Examples:   Dr.  

               Ms.  

               Capt.  

 

 
3.10.3 Field 3 Patron Suffix:  10 characters, display only 
Purpose: To specify the Patron Suffix which contains information such as Jr., Sr., M.D., etc.  
 

Format: The patron suffix field may contain any combination of letters, numbers, and punctuation.  
 

  

   Examples:  III  

              Jr.  

              Sr.  

              M.D.  
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3.10.4 Field 4 Message Area:  76 characters, multiple, display only 
Displays a message from the software to the user.  
 

Example: Display the bib or item being processed.  
 
3.10.5 Field 5 Function:  55 characters, display only 
Purpose: To specify the exact window function. The window title might be broader than this specific term.  
 
3.10.6 Field 6 Patron Expiration Date:  10 characters, display only 
Purpose: This date is when the patron's borrowing privileges will expire. The patron will not be allowed to 
borrow past this date. If the value is blank, then the patron will not expire.  
 

Format: It is any valid date. The date must not follow the patron Expiration Date. If today is January 2, 
1999, and the target date is January 12th, then any of these values will work:  
 

     12 or +10 or 1/12 or 01/12/99 or 01/12/1999  

 

 
3.10.7 Field 7 E-mail Address:  50 characters, multiple, display only 
Purpose: To specify the patron e-mail address(es).  
 

Format: The e-mail address should have the form where there are some letters and/or numbers followed 
by the "at" symbol which is then followed by the host mail server.  
 
Discussion: The e-mail address typically is made up of a User ID and a mail server address separated by 
an "at" symbol.  
 

   Examples:  doe_j@gum.com  

              123@hotmail.com  

 

 
3.10.8 Field 8 Overdue Loans Fines:  8 characters, display only 
Purpose: To display the fine total of all Overdue Loans.  
 
3.10.9 Field 9 Overdue Loans Count:  4 characters, display only 
Purpose: To display the total number of Overdue Loans.  
 
3.10.10 Field 10 Fines Not Paid:  8 characters, display only 
Purpose: To display the total monetary amount of all Fines Not Paid.  
 
3.10.11 Field 11 Lost and Damaged:  8 characters, display only 
Purpose: To display the total amount of all the items that were Lost or Damaged.  
 
3.10.12 Field 12 Conditional Return Count:  4 characters, display only 
Purpose: To display the total number of Conditional Returns.  
 
3.10.13 Field 13 Count of Fines Not Paid:  4 characters, display only 
Purpose: To display the total number of Fines Not Paid.  
 
3.10.14 Field 14 Count of Recalled Loans:  4 characters, display only 
Purpose: To display the total number of Recalled Loans.  
 
3.10.15 Field 15 Loans Count:  4 characters, display only 
Purpose: To display the total number of Loans.  
 
3.10.16 Field 16 Holds Waiting Count:  4 characters, display only 
Purpose: To display the total number of Holds Waiting.  
 
3.10.17 Field 17 Holds Pending Count:  4 characters, display only 
Purpose: To display the total number of Holds Pending.  
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3.10.18 Field 18 Claimed Returned Count:  4 characters, display only 
Purpose: To display the total number of items claimed returned.  
 
3.10.19 Field 19 Lost and Damaged Count:  4 characters, display only 
Purpose: To display the total number of items Lost or Damaged.  
 
3.10.20 Field 20 Advance Due Reminder:  2 characters, display only 
Purpose: To specify the number of days in Advance of a Due Date to e-mail a reminder to the patron.  
 

Format: It is any positive integer.  
 
3.10.21 Field 21 Patron Look Up:  7 characters 
In Patron Self Loan, Patron Look Up is deactivated. In the Circulation module, the patron may be 
retrieved by entering one of following patron values: 
 

1. Name. When the patron is an individual, then use the format LAST,FIRST. Portions of the name can be 
used. For example, "DO,JO" will find John Doe.  
 

2. Bar code. Scan or type the entire bar code.  
 

3. Local or home telephone number(s). Punctuation is ignored. This may be a truncated entry, e.g., 123-
456 will find 123-456-7890 and possibly 9998 (or more) additional entries.  
 

4. System's patron identifier number.  
 

5. Additional identifier, e.g., university or employee identifier.  
 

6. Email address. For example, jdoe@gmail.com can be found as jdoe, jdoe@g, or the entire address.  
 

After entering any value, press Enter to start the lookup.  
 
3.10.22 Field 22 Menu for Loan Functions:   
Function [Close] closes Patron Self Loan. In the Circulation module, it returns the user to the circulation 
menu. 
 
Function [Patron Edit] is deactivated in Patron Self Loan. In the Circulation module, it invokes the function 
with the same name as on the main Circulation Menu. The entire patron record may be edited. 
 
Function [Pay Fees] is deactivated in Patron Self Loan. In the Circulation module, it remits or waives 
accrued lost or damaged fees.  
 

Function [Print] outputs specified data regarding the patron's record and transactions, including an 
optional format of a loan receipt, for example:  
 

 32116 Doe,John  

 Local Address:                          Home Address:  

 Laboratory                              1 Home Lane  

                                         Lowell,MA  01851  

 X 4321                                  123-4567  

  

 E-mail: doej@coldmail.com  

  

 Due 03/29/2002 14:16  

 The New England journal of medicine.  

 Volume 340/Issue 1/Year 1999/Copy 1  

  

 Due 04/09/2002 22:00  

 Gould, Stephen Jay.  

 Hen's teeth and horse's toes /  
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Function [Show Detail] displays the title and item specifics of all current loans, holds, outstanding fees 
and fines, for example:  
 

 Overdue Loan        Fine $  20.00  Notice sent on 05/30/02  

 Out:      05/10/02  Wolff, Harold G.  

 Due:      05/24/02  Wolff's Headache and other head pain.  

           03:00 PM  WL 342 W8552 1980  

                     MARC# 14391   Item# 18        Barcode D10017  

 

 

Menu Style:  Push Button 

Menu Values: 

Print Loan Receipt 

Pay Fines 

E-mail Loan Receipt 

Pay Fees 

Show Detail 

Print 

Patron Edit 

Help 

Close 

 

Function [Print Loan Receipt] prints a loan receipt for the patron's loans for the day. Options can be found 
on function [Print].  
 

Function [Email Loan Receipt] sends a loan receipt via e-mail for the patron's loans for the day. There are 
no options or additional pop-up windows. If [Email Loan Receipt} is selected but the patron record has no 
email, then the process automatically moves to the [Print] window.  
 
3.10.23 Field 23 Date of Loan:  12 characters 
Purpose: To specify the date of the loan. This field may be non-editable in some systems.  
 

Format: It is any reasonable date format such as NN/NN/NNNN. No future dates.  
 
3.10.24 Field 24 Time of Loan:  8 characters 
Purpose: To specify the time of the loan. This field may not be editable in all catalogs.  
 

Format: It is any reasonable time format, e.g., 2 PM may be entered as  
 

     1400  

     14:00  

     2P  

     2PM  

     2 PM  

 

 
3.10.25 Field 25 Find Item:  120 characters 
Specifies numbers or words that might identify an item or the MARC bib associated with the item. If the 
MARC bib is found, all of its associated items are displayed for selection.  
 

Format: Free text, but in conjunction with the search method to be selected in the following field. A bar 
code may be scanned here to hasten the process.  
 
3.10.26 Field 26 Find Menu:   
Specifies the appropriate look up that matches the entry made in the textual Find field.  
 

Format: It is a menu selection.  
 
Menu Style:  Push Button 
Menu Values: 
Bar Code 
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Item # 
MARC # 
Call # 
Title 
Author 
ISBN/ISSN/LCCN 
 
Discussion:  
 

Function [Bar Code] will attempt to match the value in the field Find to the index of Bar Code values. The 
software will also test if the bar code is an acceptable bar code value, e.g., not a patron's bar code. This 
value cannot be truncated.  
 

[Item #] will attempt to match the value in the field Find to the list of Item Numbers. This value cannot be 
truncated.  
 

[MARC #] will attempt to match the value in the field Find to the list of MARC Numbers. This value cannot 
be truncated.  
 

[Call #] will attempt to match the value in the field Find to the index of Call Numbers. This value may be 
truncated but must be in context, e.g., "WB 115 H323" for all editions of Harrison's Principles of internal 
medicine.  
 

[Title] will attempt to match the value in the field Find to the series authority file. This value may be 
truncated and out of context, e.g. "new eng med" for the New England Journal of Medicine, but the word 
fragments must be greater than one Character each.  
 

[Author] will attempt to match the value in the field Find to the author authority file. This value may be 
truncated, e.g., "Ein,Al" for Albert Einstein.  
 

[MARC #] will attempt to match the value in the field Find to the list of MARC Numbers. This value cannot 
be truncated.  
 

[ISBN, ISSN, or LCCN] will attempt to match the value in the field Find to the index of ISBN (MARC bib 
tag 020), ISSN (MARC bib tag 020), or LCCN (MARC bib tag 010) Numbers. This value cannot be 
truncated.  
 

[Control #] will attempt to match the value in the field Find to the index of MARC bib tag 001 Control 
Number. The exact value can be entered. If the value has an alphabetic prefix then the prefix can be 
removed, e.g., ocm16523764 can be entered as 16523764. The value cannot be end truncated.  


